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External Power Supply (5-12V)

CAN Communication Bus

RGB LED

S32K142 MCU

LIN Communication Bus

OpenSDA USB

Reset Button

OpenSDA MCU

OpenSDA JTAG

Potentiometer

User Buttons

Get to know S32K142-EVB

J2 Header

J1 Header

J6 Header

J3 Header

J4 Header

J5 Header

SBC UJA1169

Touch electrodes

J14 SWD connector.
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S32K142 EVB Features:

• Supports S32K142 and S32K144  100LQFP

• Small form factor size supports up to 6” x 4”

• Arduino™ UNO footprint-compatible with expansion “shield” support

• Integrated open-standard serial and debug adapter (OpenSDA) with 
support for several industry-standard debug interfaces

• Easy access to the MCU I/O header pins for prototyping

• On-chip connectivity for CAN, LIN, UART/SCI. 

• SBC UJA1169 and LIN phy TJA1027

• Potentiometer for precise voltage and analog measurement

• RGB LED

• Two push-button switches (SW2 and SW3) and two touch electrodes

• Flexible power supply options

• microUSB

• external 12V power supply
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Header/Pinout Mapping for S32K142

Arduino compatible pins
NXP pins

PIN PORT FUNCTION J3 PIN PORT FUNCTION
J3-02 PTB6* GPIO J3-01 VIN 
J3-04 PTB7* GPIO J3-03 IOREF
J3-06 PTE0 GPIO J3-05 PTA5 RESET
J3-08 PTE9 GPIO J3-07 3V3
J3-10 PTC5 GPIO J3-09 5V
J3-12 PTC4 GPIO J3-11 GND
J3-14 PTA10 GPIO J3-13 GND
J3-16 PTA4 GPIO J3-15 VIN

PIN PORT FUNCTION J4 PIN PORT FUNCTION
J4-02 PTC7 GPIO J4-01 PTD4 ADC0
J4-04 PTC6 GPIO J4-03 PTB12 ADC1
J4-06 PTB17 GPIO J4-05 PTB0 ADC2
J4-08 PTB14 GPIO J4-07 PTB1 ADC3
J4-10 PTB15 GPIO J4-09 PTA6/PTE11/PTA2 ADC4
J4-12 PTB16 GPIO J4-11 PTC0/PTE10/PTA3 ADC5
J4-14 PTC14 GPIO J4-13 PTE2 ADC6
J4-16 PTC3 GPIO J4-15 PTE6 ADC7

PIN PORT FUNCTION J5 PIN PORT FUNCTION
J5-02 PTE16 GPIO J5-01 PTA15/PTD11 ADC8
J5-04 PTE15 GPIO J5-03 PTA16/PTD10 ADC9
J5-06 PTE14 GPIO J5-05 PTA1 ADC10
J5-08 PTE13 GPIO J5-07 PTA0 ADC11
J5-10 VDD J5-09 PTA7 ADC12
J5-12 GND J5-11 PTB13 ADC13
J5-14 PTE1 GPIO J5-13 PTC1 ADC14
J5-16 PTD7 GPIO J5-15 PTC2 ADC15
J5-18 PTD6 GPIO J5-17 NC GPIO
J5-20 PTC15 GPIO J5-19 NC N/A

PIN PORT FUNCTION J2 PIN PORT FUNCTION
J2-19 PTE10/PTA3 D15/I2C_SDA J2-20 NC GPIO
J2-17 PTE11/PTA2 D14/I2C_CLK J2-18 NC GPIO
J2-15 ANALOGUE REF J2-16 PTA14 GPIO
J2-13 GND J2-14 PTE7 GPIO
J2-11 PTB2 D13/SPI_SCK J2-12 PTC13 GPIO
J2-09 PTB3 D12/SPI_SIN J2-10 PTC12 GPIO
J2-07 PTB4 D11/SPI_SOUT J2-08 PTE8 GPIO
J2-05 PTB5 D10/SPI_CS J2-06 PTD0 GPIO
J2-03 PTD14 D9/PWM J2-04 PTD16 GPIO
J2-01 PTD13 D8/PWM J2-02 PTD15 GPIO

PIN PORT FUNCTION J1 PIN PORT FUNCTION
J1-15 PTC11/PTE8 D7 J1-16 PTE3 GPIO
J1-13 PTC10/PTC3 D6 J1-14 PTD3 GPIO
J1-11 PTB11 D5 J1-12 PTD5 GPIO
J1-09 PTB10 D4 J1-10 PTD12 GPIO
J1-07 PTB9 D3 J1-08 PTD11 GPIO
J1-05 PTB8 D2 J1-06 PTD10 GPIO
J1-03 PTA3 D1 J1-04 PTA17 GPIO
J1-01 PTA2 D0 J1-02 PTA11 GPIO

PIN PORT FUNCTION J6 PIN PORT FUNCTION
J6-19 PTA9 D14 J6-20 PTE4 GPIO
J6-17 PTA8 D15 J6-18 PTE5 GPIO
J6-15 PTE12 D16 J6-16 PTA12 GPIO
J6-13 PTD17 D17 J6-14 PTA13 GPIO
J6-11 PTC9 D18 J6-12 GND
J6-09 PTC8 D19 J6-10 VDD
J6-07 PTD8 D20 J6-08 PTC16 GPIO
J6-05 PTD9 D21 J6-06 PTC17 GPIO
J6-03 PTD2 GPIO J6-04 PTD3 GPIO
J6-01 PTD0 GPIO J6-02 PTD1 GPIO

J2

J1

J6

J3

J4

J5

*0ohm resistor is not connected
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Jumper Settings

Jumper Configuration Description

J104 1-2

2-3 (Default)

Reset signal to OpenSDA, use to enter into 
OpenSDA Bootloader mode 

Reset signal direct to the MCU, use to reset 
S32K142.

J107 1-2

2-3 (Default)

S32K142 powered by 12V power 
source.

S32K142 powered by USB micro 
connector.

J10 2-3 (Default)

1-2

MCU voltage 5v

MCU voltage 3.3v
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HMI mapping
Component S32K142
Red LED PTD15 (FTM0 CH0)

Blue LED PTD0(FTM0 CH2)

Green LED PTD16(FTM0 CH1)

Potentiometer PTC14 (ADC0_SE12)

SW2 PTC12

SW3 PTC13

OpenSDA UART TX PTC7(LPUART1_TX)

OpenSDA UART RX PTC6(LPUART1_RX)

CAN TX PTE5(CAN0_TX)

CAN RX PTE4 (CAN0_RX)

LIN TX PTC3(LPUART0_TX)

LIN RX PTC2 (LPUART0_RX)

SBC_SCK PTB14 (LPSPI1_SCK)

SBC_MISO PTB15(LPSPI1_SIN)

SBC_MOSI PTB16(LPSPI1_SOUT)

SBC_CS PTB17(LPSPI1_PCS3)
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S32K142 EVB RevC. LIN Phy errata. 

• Errata: the LIN phy on S32K142EVB is connected to S32K142’s pins 32/31 which don’t support 
LPUART.

• Workaround:  Connect MCU’s pin 29 to LIN Phy’s LIN_TX trace and MCU’s pin 30 to LIN Phy’s
LIN_RX trace at PCB level. This can be done by removing R131 and R130, connecting pad 1 of 
R132(DNP) to pad 2 of R131 and pad 2 of R130 to MCU’s pin 30 via, as shown below. 

Note: this errata is already fix on 
newest EVB version. 
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S32K142 EVB 
OUT OF THE BOX
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Step 1: Power up the Board – EVB Power Supplies

• The S32K142-EVB evaluation board powers from a USB 
or external 12V power supply. By default USB power is 
enabled with J107 (check slide 5)

• Connect the USB cable to a PC using supplied USB 
cable .

• Connect other end of USB cable (microUSB) to mini-B 
port on S32K142-EVB at J7 

• Allow the PC to automatically configure the USB drivers if 
needed

• Debug is done using OpenSDA through J7
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Step 1: Power up the Board – Is it powered on correctly? 

• When powered through USB, LEDs D2 and D3 should light green

• Once the board is recognized, it should appear as a mass storage 
device in your PC with the name EVB-S32K142. 
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Step 1: Power up the Board – Is it powered on correctly? 

• Board is preloaded with a software, in 
which the red, blue and green leds will 
toggle at different rates.
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S32K142 EVB
OUT OF THE BOX

EXPERIENCE
BASED ON THE 

FREEMASTER TOOL
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Install the FreeMASTER tool

 Download and install the FreeMASTER PC application www.nxp.com/FreeMASTER .

 Open the FreeMASTER application on your PC. You should see Welcome page:
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Power up the EVB board

 Powers the S32K142EVB evaluation board from a 
USB. By default, the USB power is enabled by J8
jumper.

 Connect the USB cable to a PC and connect micro
USB connector of the USB cable to micro-B port J7 
on the S32K14EVB.

 Allow the PC to automatically configure the USB 
drivers if needed.

 When EVB is powered from USB, LEDs D2 and D3 
should light green.

 The EVB board is preloaded with a software 
toggling the RGB LED colours periodically between 
RED-GREEN-BLUE.
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Setup serial connection in the FreeMASTER tool

 Setup communication manualy: 
„Project > Options > Comm“

OR

 Setup communication automatically:
„Tools > Connection Wizard“

Setup communication port to „opensda“ and speed to 115200 b/s:
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The FreeMASTER Out-Of-Box-Experience (OOBE) project   
will be automaticaly downloaded from www.nxp.com

Once the FreeMASTER application detects the web address stored as an TSA active content in the flash 
memory of the S32K142 MCU, the download of the FreeMASTER project from www.nxp.com will be initiated.
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The FreeMASTER OOBE project is loaded
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The FreeMASTER OOBE project description 

Links to S32K14x docs:
 Fact Sheet
 Data Sheet
 Reference Manual
 Product Brief
 S32K14xEVB schematic
 S32K14xEVB Quick Start 

Guide
 Tools:

 FreeMASTER
 S32 Design Studio IDE

 S32K14xEVB OOBE source 
files

Pins of the J2, J1 and J6 connectors are configured as outputs. By 
single click on each pin you can change their logical level to log0 

or log1. User can connect e.g. LED diodes to these ouput pins. 

Pins of the J3, J4 and J5 connectors are configured as inputs. 
Logical level (log0/log1) is visualised for all connector pins. 

User can connect e.g. push-button keyboard to these input pins. 

RGB 
LED

Potentiometer

Touch Sense Electrodes

Mechanical 
Buttons
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The FreeMASTER OOBE oscilloscope feature examples

 Display main project panel „Project > View > Project Tree“.

 Display real-time oscilloscope graph examples such as „Potentiometer“ or „Touch Sense Electrodes“.

Analog values from potentiometer. Responses from touch sense electrodes.
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INTRODUCTION TO 
OPENSDA
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Introduction to OpenSDA: 1 of 2

OpenSDA is an open-standard serial and debug adapter. It bridges serial and debug communications between a USB host and an 
embedded target processor. OpenSDA software includes a flash-resident USB mass-storage device (MSD) bootloader and a 
collection of OpenSDA Applications. S32K142 EVB comes with the MSD Flash Programmer OpenSDA Application preinstalled. 
Follow these instructions to run the OpenSDA Bootloader and update or change the installed OpenSDA Application.

IMPORTANT NOTE:  Follow the “Load an OpenSDA
Application” instructions to update the MSD Flash 
Programmer on your S32K142 EVB  to the latest 
version. 

Enter OpenSDA Bootloader Mode

1. Unplug the USB cable if attached

2. Set J104 on position 1-2.

3. Press and hold the Reset button (SW5)

4. Plug in a USB cable (not included) between a 
USB host and the OpenSDA USB connector 
(labeled “SDA”)

5. Release the Reset button

A removable drive should now be visible in the host 
file system with a volume label of BOOTLOADER. 
You are now in OpenSDA Bootloader mode.

Load an OpenSDA Application

1. While in OpenSDA Bootloader mode, double-click 
SDA_INFO.HTML in the BOOTLOADER drive. A web 
browser will open the OpenSDA homepage containing the 
name and version of the installed Application. This 
information can also be read as text directly from 
SDA_INFO.HTML

2. Locate the OpenSDA Applications 

3. Copy & paste or drag & drop the MSD Flash Programmer 
Application to the BOOTLOADER drive 

4. Unplug the USB cable and plug it in again. The new 
OpenSDA Application should now be running and a 
S32K142 EVB drive should be visible in the host file 
system

You are now running the latest version of the MSD Flash 
Programmer. Use this same procedure to load other OpenSDA
Applications.
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Introduction to OpenSDA: 2 of 2

The MSD Flash Programmer is a composite USB application that provides a virtual serial port and an easy and convenient way to
program applications into the S32K142 MCU. It emulates a FAT file system, appearing as a removable drive in the host file system with 
a volume label of EVB-S32K142. Raw binary and Motorola S-record files that are copied to the drive are programmed directly into the 
flash of the S32K142 and executed automatically. The virtual serial port enumerates as a standard serial port device that can be opened 
with standard serial terminal applications. 

NOTE:  Flash programming with the MSD Flash Programmer is 
currently only supported on Windows operating systems. 
However, the virtual serial port has been successfully tested on 
Windows, Linux and Mac operating systems. 

Using the MSD Flash Programmer 
1. Locate the .srec file of your project , file is under the 

Debug folder of the S32DS project. 

2. Copy & paste or drag & drop one of the .srec files to 
the EVB-S32K142 drive

The new application should now be running on the 
S32K142 EVB. Starting with v1.03 of the MSD Flash 
Programmer, you can program repeatedly without the 
need to unplug and reattach the USB cable before 
reprogramming. 

Drag one of the .srec code for the S32K142. the S32K142 
EVB board over USB to reprogram the preloaded code 
example to another example.

Using the Virtual Serial Port
1. Determine the symbolic name assigned to the EVB-S32K142 

virtual serial port. In Windows open Device Manager and look 
for the COM port named “PEMicro/Freescale – CDC Serial 
Port”.

2. Open the serial terminal emulation program of your choice. 
Examples for Windows include Tera Term, PuTTY, and 
HyperTerminal

3. Press and release the Reset button (SW5) at anytime to 
restart the example application. Resetting the embedded 
application will not affect the connection of the virtual serial 
port to the terminal program.

4. It is possible to debug and communicate with the serial port 
at the same time, no need to stop the debug.

NOTE:   Refer to the OpenSDA User’s Guide for a description of a known 
Windows issue when disconnecting a virtual serial port while the COM 
port is in use. 
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INSTALLING S32DS
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Download S32DS 

Download S32DS from:

S32DS for ARM
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CREATE A NEW 
PROJECT IN S32 
DESIGN STUDIO
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Create New Project: First Time – Select a Workspace

• Start program: Click on “S32 Design Studio for ARM v2.0” icon 

• Select workspace:  

− Choose default (see below example) or specify new one

− Suggestion: Uncheck the box “Use this as the default and do not ask again”

− Click OK
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Create New Project: Top Menu Selection 

• File – New –Project
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Create New Project: S32DS Project

• Project Name:  

− Example: FirstProject

• Project Type: 

− Select from inside 
executable or library folder

• Next
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Create New Project: S32DS Project

• Select Debugger Support and Library Support

• Click Finish
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OpenSDA Configuration

• To Debug your project with OpenSDA, it is necessary to select the OpenSDA in the 
Debug Configuration.

• Select your project, and click on debug configuration
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OpenSDA Configuration

• Select the Debug configuration under GDB PEMicro Interface Debugging

• Click on Debugger tab
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OpenSDA Configuration

• Select OpenSDA as the interface, if your board is plugged should appear in the 
Port field.

• Click Apply and debug to finish.
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CREATE AN EXAMPLE 
FROM SDK
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Creating example from SDK

• The S32 Design Studio IDE already includes the Software Development Kit for 
quickly develop applications on S32K1xx devices. 

• To create a project using an example go to File – New –Project
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Creating example from SDK

• Go to the S32K14x EAR SDK v0.8.6 Example Projects section and select the 
example that wants to be used.

• In this example the hello_world is selected
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Creating example from SDK

• A new project would be created in the workspace. Then click on generate code icon and then on 
debug, as indicated.

• If run correctly, the LED should start blinking red and green.
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Creating example from SDK

• The complete documentation of the SDK can be found in: 
C:\NXP\S32DS_ARM_v2018.R1\S32DS\S32SDK_S32K14x_EAR_0.8.
6\doc\Start_here.html

• For more information about the use of the SDK go click on the following 
link for an SDK tranining (add hyperlink once if is online)
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DEBUG BASICS
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Debug Basics: Starting the Debugger

• Debug configuration is only required once. Subsequent starting of debugger does 
not require those steps.

• Three options to start debugger:

− If the “Debug Configuration” has not been closed, click on “Debug” button on bottom right

− Select Run – Debug (or hit F11)

Note: This method currently selects the desktop target (project.elf) and gives an error. Do 
not use until this is changed.

− Recommended Method: Click on pull down arrow for bug icon and select …_debug.elf
target



EXTERNAL USE40

Debug Basics: Step, Run, Suspend, Resume

• Step Into (F5)

• Step Over (F6)

• Step Return (F7)

• Run

• Suspend 

• Resume (F8)
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Debug Basics: View & Alter Variables

• View variables in “Variables” tab.  

• Click on a value to allow typing in a different value.
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Debug Basics: View & Alter Registers

• View CPU registers in the “Registers” tab

• Click on a value to allow typing in a different value

• View peripheral registers in the EmbSys Registers tab
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Debug Basics: View & Alter Memory  

• Add Memory Monitor

• Select Base Address 

to Start at : 40000000

• View Memory
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Debug Basics: Breakpoints

Add Breakpoint: Point and Click

• light blue dot represents debugger breakpoint
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Debug Basics: Reset & Terminate Debug Session

• Reset program counter

• Terminate Ctl+F2() 
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CREATE A P&E DEBUG 
CONFIGURATION 

(OPTIONAL)
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New P&E debug configuration

• Click in debug configurations
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New P&E debug configuration

• Create a new P&E launch configuration

Click to create a new 
P&E launch

Click on the debugger tab.
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New P&E debug configuration

• Select the device 

• Click Apply and debug your application

Select 
device
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USEFUL LINKS



EXTERNAL USE51

Useful Links

• Cookbook application note. This application note contains a
bunch of simple examples of how to use different
peripherals.

• S32K1xx community. Visit this site for request support on
the S32K1xx products, you can also look for threads that
may contain the answer that you are looking for.




